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These release notes contain information on downloading software, new and changed support, new and 
changed functionality, limitations and restrictions, open and resolved caveats, and documentation 
updates for Cisco Unity Connection Release 7.0(2) and for Connection in Cisco Unified 
Communications Manager Business Edition (CMBE) Release 7.0(2).

Note Cisco Unity Connection is a Linux-based solution. It is available in two configurations—Cisco Unity 
Connection, and Cisco Unified Communications Manager Business Edition, in which Connection is 
preloaded on the same platform with Cisco Unified Communications Manager. These release notes 
contain information for both configurations.
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  System Requirements
System Requirements

For Cisco Unity Connection
System Requirements for Cisco Unity Connection Release 7.x contains the most current Connection 
requirements. The document is available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucsysreqs.html.

For Cisco Unity Connection in Cisco Unified CMBE
System Requirements for Cisco Unity Connection in Cisco Unified CMBE Release 7.x contains the most 
current Connection requirements. The document is available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucmbesysreqs.html
.

Compatibility Information
The following documents list the most current version combinations qualified for use with Cisco Unity 
Connection, and with Connection in Cisco Unified CMBE (where applicable):

• Compatibility Matrix: Cisco Unity Connection and the Software on User Workstations 

• SCCP Compatibility Matrix: Cisco Unity Connection, Cisco Unified Communications Manager, and 
Cisco Unified Communications Manager Express

• SIP Trunk Compatibility Matrix: Cisco Unity Connection, Cisco Unified Communications Manager, 
and Cisco Unified Communications Manager Express

The documents are available on Cisco.com at 
http://www.cisco.com/en/US/products/ps6509/products_device_support_tables_list.html.

Determining the Software Version
This section contains procedures for determining the version in use for the following software:

• Cisco Unity Connection, page 2

• Cisco Personal Communications Assistant, page 3

Cisco Unity Connection

To Determine the Cisco Unity Connection Version by Using Cisco Unity Connection Administration

Step 1 In Cisco Unity Connection Administration, in the upper-right corner below the Navigation list, click 
About. 

The Connection version is displayed below “Cisco Unity Connection Administration.”
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  Related Documentation
To Determine the Cisco Unity Connection Version by Using the Command-Line Interface

Step 1 Start a command-line interface (CLI) session. For more information, see the Cisco Unified 
Communications Operating System Administration Help. 

Step 2 Run the show cuc version command. 

Cisco Personal Communications Assistant

To Determine the Cisco Personal Communications Assistant (PCA) Version

Step 1 Log on to the Cisco PCA.

Step 2 On the Cisco PCA Home page, click About in the upper right corner. (The link is available on every web 
tool page.)

The Cisco Unity Connection version is displayed. The Cisco PCA version is the same as the Connection 
version.

Related Documentation

For Cisco Unity Connection
For descriptions and URLs of Cisco Unity Connection documentation on Cisco.com, refer to the 
Documentation Guide for Cisco Unity Connection Release 7.x. The document is shipped with 
Connection and is available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/roadmap/7xcucdg.html.

For Cisco Unified Communications Manager Business Edition
For descriptions and URLs of Cisco Unified Communications Manager Business Edition documentation 
on Cisco.com, refer to the Cisco Unified Communications Manager Business Edition Documentation 
Guide. The document is shipped with Cisco Unified CMBE and is available at 
http://www.cisco.com/en/US/products/ps7273/products_documentation_roadmaps_list.html.

Note The documentation links on Cisco.com for some Cisco Unity Connection in Cisco Unified CMBE 7.x 
versions go to documents that are labeled for Cisco Unity Connection Release 7.x. Despite the version 
label, all content in the following guides applies to both Connection configurations: Administration 
Guide for Cisco Unity Connection Serviceability, Interface Reference Guide, System Administration 
Guide, Troubleshooting Guide, User Moves, Adds, and Changes Guide, User Workstation Setup Guide, 
and the Cisco Unity Connection Voice Commands wallet card.
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  New and Changed Requirements and Support—Release 7.0(2)
New and Changed Requirements and Support—Release 7.0(2)
This section contains information about new and changed requirements and support in the 7.0(2) release 
time frame only. Refer to the release notes of the applicable version for information on new and changed 
support with earlier versions of Cisco Unity Connection.

Release notes for all versions of Cisco Unity Connection are available at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html. 

Release notes for all versions of Cisco Unified Communications Manager Business Edition are available 
at http://www.cisco.com/en/US/products/ps7273/prod_release_notes_list.html.

Additional Languages for Cisco Unity Connection Components
There are no new languages for this release.

For a complete list of languages, refer to the “Available Languages for Cisco Unity Connection 
Components” section of the applicable System Requirements:

• System Requirements for Cisco Unity Connection Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucsysreqs.html
.

• System Requirements for Cisco Unity Connection in Cisco Unified CMBE Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/requirements/7xcucmbesysreqs.
html.

(For a list of numeric and alphabetic language codes, refer to the “Numeric and Alphabetic Codes for 
Supported Languages in Cisco Unity Connection” section of the 7.x System Requirements.)

Calendar Integration with Exchange 2007 Server Is No Longer Supported
Added July 9, 2010
A calendar integration with Exchange 2007 Server is no longer supported in Cisco Unity Connection 
7.0(2).

The “Creating a Calendar Integration with Exchange 2007” section in the “Creating Calendar 
Integrations” chapter of the System Administration Guide for Cisco Unity Connection Release 7.x (at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/administration/guide/7xcucsagx.htm
l) incorrectly indicates that calendar integrations with Exchange 2007 Server are supported.

Note however that contact and text to speech integrations are still supported with Exchange 2007 Server.

Phone System Integrations

For Cisco Unity Connection

There are no new phone system integrations qualified with this release.
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  New and Changed Requirements and Support—Release 7.0(2)
For supported versions of Cisco Unified CM and Cisco Unified CM Express, refer to the applicable 
document, depending on the integration type:

• SCCP Compatibility Matrix: Cisco Unity Connection, Cisco Unified Communications Manager, and 
Cisco Unified Communications Manager Express at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/compatibility/matrix/cucsccpmtx.ht
ml.

• SIP Trunk Compatibility Matrix: Cisco Unity Connection, Cisco Unified Communications Manager, 
and Cisco Unified Communications Manager Express at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/compatibility/matrix/cucsiptrunkmt
x.html.

For information on other supported phone system integrations, refer to the applicable Cisco Unity 
Connection integration guides at 
http://www.cisco.com/en/US/products/ps6509/products_installation_and_configuration_guides_list.ht
ml.

For Cisco Unity Connection in Cisco Unified CMBE

Cisco Unified Communications Manager 7.0 has been qualified for use with Cisco Unified CMBE. It is 
installed on the same platform with Cisco Unity Connection.

Selected Servers Require Replacement Hard Disks or Additional Memory for 
Some Configurations

If you are upgrading from a version of Cisco Unity Connection earlier than 7.0(1) and you want to reuse 
the current server, for some servers and some configurations you must replace hard disks or add memory. 
For example:

• Some servers require replacement hard disks if you are configuring a Connection cluster.

• Some servers require additional memory if voice recognition and Digital Networking are configured 
when the sum of contacts, users, distribution lists, locations, personal contacts, and personal 
distribution lists exceeds 2,000. (These are the first six items on the Tools > Grammar Statistics page 
in Cisco Unity Connection Administration.)

See the Cisco Unity Connection Supported Platforms List at 
http://www.cisco.com/en/US/products/ps6509/products_data_sheets_list.html to determine whether 
your server requires replacement hard disks or additional memory. 

For information on replacing the hard disks or adding the memory, refer to the applicable upgrading 
chapter in the Reconfiguration and Upgrade Guide for Cisco Unity Connection at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/upgrade/guide/7xcucrugx.html.

Software Qualified for Use on Cisco Unity Connection User Workstations
There is no new software for user workstations qualified with this release.

For the most current version combinations of software qualified for use on user workstations, refer to 
Compatibility Matrix: Cisco Unity Connection and the Software on User Workstations at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/compatibility/matrix/cucclientmtx.html
.
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  New Functionality—Release 7.0(2)
Utility Updates on the Cisco Unity Tools Website
Updates to utilities on the Cisco Unity Tools website are frequently posted between Cisco Unity 
Connection releases. The updates commonly do not apply to a specific release, so we do not list the tools 
that have been updated since the last version of Connection. However, you can sign up to be notified 
when the utilities posted on the Cisco Unity Tools website are updated. Go to 
http://www.ciscounitytools.com, and click Sign Up Here.

Visual Voicemail
Cisco Unity Connection supports Visual Voicemail, part of the Cisco Unified Communications Widgets 
suite of applications. Visual Voicemail allows users to view, listen, compose, forward, delete, and 
respond to voice messages from their Cisco Unified IP Phone display without having to dial into their 
Connection mailboxes.

Visual Voicemail provides enhanced functionality compared with Cisco Unity Connection PhoneView. 
We recommend using Visual Voicemail instead of the older feature.

For system requirements and information on installing, configuring, and using Visual Voicemail, see the 
documentation at 
http://www.cisco.com/en/US/products/ps9829/tsd_products_support_series_home.html.

You Cannot Upgrade from Connection 2.1(3) to 7.0(1) or 7.0(2)
A change that was made to Connection in version 2.1(3) prevents upgrades from version 2.1(3) to 
Connection 7.0(1) or 7.0(2). To upgrade from Connection 2.1(3), you will need to wait for Connection 
7.1(2) to be released, in the second quarter of 2009. 

New Functionality—Release 7.0(2)
There is no new functionality in this release. See the “Resolved Caveats—Connection Release 7.0(2), 
and Connection in Cisco Unified CMBE Release 7.0(2)” section on page 22.

Refer to the release notes of the applicable version for information on new functionality in earlier 
versions of Cisco Unity Connection.

Release notes for all versions of Cisco Unity Connection are available at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html. 

Release notes for all versions of Cisco Unified Communications Manager Business Edition are available 
at http://www.cisco.com/en/US/products/ps7273/prod_release_notes_list.html.

Note that the Cisco Unity Tools website may offer scripts and applications that were not included in 
Cisco Unity Connection 7.0(2). Some offerings may not be supported by Cisco TAC. Refer to 
http://www.ciscounitytools.com for information.

Changed Functionality—Release 7.0(2)
There is no changed functionality in this release. See the “Resolved Caveats—Connection Release 
7.0(2), and Connection in Cisco Unified CMBE Release 7.0(2)” section on page 22.
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  Installation and Upgrade Information
Refer to the release notes of the applicable version for information on changed functionality in earlier 
versions of Cisco Unity Connection.

Release notes for all versions of Cisco Unity Connection are available at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html. 

Release notes for all versions of Cisco Unified Communications Manager Business Edition are available 
at http://www.cisco.com/en/US/products/ps7273/prod_release_notes_list.html.

Note that the Cisco Unity Tools website may offer scripts and applications that were not included in 
Cisco Unity Connection 7.0(2). Some offerings may not be supported by Cisco TAC. Refer to 
http://www.ciscounitytools.com for information.

Installation and Upgrade Information
• Information for Cisco Unified Communications Manager Business Edition Customers, page 7

• Installing Cisco Unity Connection for the First Time, page 8

• Supported Cisco Unity Connection Upgrades, page 8

• Upgrading from Cisco Unity Connection 7.0(1) to 7.0(2), page 8

• Upgrading from Cisco Unity Connection 2.x to 7.0(2), page 14

• Migrating from Cisco Unity or from Cisco Unity Connection 1.x to Cisco Unity Connection 7.0, 
page 16

• Installation and Upgrade Notes, page 16

Information for Cisco Unified Communications Manager Business Edition 
Customers

• For instructions on installing a new Cisco Unified CMBE system, see Overview of Mandatory Tasks 
for Setting Up a Cisco Unified Communications Manager Business Edition 7.x System at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/cucmbe_task_list/7xcucmbetask
.html and the Installing Cisco Unified Communications Manager Business Edition Release 7.0 at 
http://www.cisco.com/en/US/products/ps7273/prod_installation_guides_list.html.

• For instructions on upgrading a Cisco Unified CMBE system, see the “Software Upgrade and 
Installation” section in the “Software Upgrades” chapter of the Cisco Unified Communications 
Operating System Administration Guide at 
http://www.cisco.com/en/US/products/ps7273/prod_maintenance_guides_list.html.

Caution If you are upgrading from Cisco Unified CMBE version 6.x and any languages other than U.S. 
English (ENU) are currently installed and in use on the 6.x system, you must install the 
Connection 7.0 versions of the same languages during the upgrade. Otherwise, the Connection 
conversation will not function properly for users who are configured to use non-ENU 
languages. For information on downloading and installing languages, see the “Downloading 
and Installing Cisco Unity Connection Languages” section on page 16.

• There is no supported migration path from Connection 1.x to Cisco Unified Communications 
Manager Business Edition (CMBE). If you want to migrate from Connection 1.x to Cisco 
Unified CMBE, you must reinstall all software, and recreate all system and user data. 
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  Installation and Upgrade Information
Installing Cisco Unity Connection for the First Time
For instructions on installing a new Cisco Unity Connection system, see the Installation Guide for 
Cisco Unity Connection Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/installation/guide/7xcucigx.html.

Supported Cisco Unity Connection Upgrades
You can upgrade from the following versions of Cisco Unity Connection directly to version 7.0(2):

• Connection 7.0(1)

• Connection 2.1(2)

• Connection 2.1(1)

• Connection 2.0(1)

Upgrading from Connection 2.1(3) to version 7.0(2) is not supported. For more information, see the 
“You Cannot Upgrade from Connection 2.1(3) to 7.0(1) or 7.0(2)” section on page 6.

Upgrading from Cisco Unity Connection 7.0(1) to 7.0(2)
This section contains information for upgrading version 7.0(1) to 7.0(2).

• Task List for Upgrading Connection 7.0(1) Software to 7.0(2) Without a Connection Cluster, page 8

• Task List for Upgrading Connection 7.0(1) Software to 7.0(2) in a Connection Cluster, page 9

• Downloading the Connection 7.0(2) Software for the Upgrade from 7.0(1), page 10

• Upgrading the Software from a Local DVD, page 11

• Upgrading the Software from a Network Location, page 12

• Switching to the Upgraded Software, page 14

Use the applicable task list to upgrade the Connection software correctly.

Task List for Upgrading Connection 7.0(1) Software to 7.0(2) Without a Connection Cluster

1. Download the upgrade software. See the “Downloading the Connection 7.0(2) Software for the 
Upgrade from 7.0(1)” section on page 10.

2. Note any applicable items in the “Installation and Upgrade Notes” section on page 16.

3. Upgrade the software on the Connection server. See the applicable section:

• “Upgrading the Software from a Local DVD” section on page 11

• “Upgrading the Software from a Network Location” section on page 12

4. If you chose to do a later restart at the end of the software upgrade in Task 3.: Switch to the upgraded 
partition. See the “Switching to the Upgraded Software” section on page 14.

(If you chose to automatically restart at the end of the software upgrade, the switch to the upgraded 
partition is complete.)
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  Installation and Upgrade Information
Task List for Upgrading Connection 7.0(1) Software to 7.0(2) in a Connection Cluster

As the upgrade software is installed, the publisher and subscriber servers continue answering calls and 
replication occurs. When the publisher server is switched to the upgraded software, the subscriber server 
answers all calls, but replication does not occur and messages may not be available. When the subscriber 
server is switched to the upgraded software, the publisher server answers all calls, but replication does 
not occur and messages may not be available. About 15 minutes after both servers are switched to the 
upgraded software, both servers answer calls, replication resumes, and messages are available.

Note the following considerations about the upgrade process:

• Installing the software upgrade requires approximately two hours for each server—a total of about 
four hours for both servers.

• Switching to the upgraded software requires a few minutes for each server.

• Messages that are recorded when switching to the upgraded software will not be replicated. 
Depending on the Connection server to which a user is logged on, the user may not be able to access 
new messages. Messages will be replicated after the upgrade process is complete.

• MWIs and notifications may not be sent. MWIs and notifications synchronize only after the upgrade 
process is complete.

• After the upgrade process is complete, the servers require about 15 minutes to renegotiate their 
server status and to replicate messages.

The following tasks reference these release notes and the Cluster Configuration and Administration 
Guide for Cisco Unity Connection Release 7.x, which is available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/cluster_administration/guide/7xcucc
agx.html.

1. Download the upgrade software. See the “Downloading the Connection 7.0(2) Software for the 
Upgrade from 7.0(1)” section on page 10.

2. Note any applicable items in the “Installation and Upgrade Notes” section on page 16.

3. Log on to Cisco Unified Serviceability and confirm that the publisher server has Primary status and 
that the subscriber server has Secondary status. For instructions, see the “Administering a 
Cisco Unity Connection Cluster” chapter of the Cluster Configuration and Administration Guide for 
Cisco Unity Connection Release 7.x.

4. Install the software upgrade on the publisher server. See the applicable section:

• “Upgrading the Software from a Local DVD” section on page 11

• “Upgrading the Software from a Network Location” section on page 12

The publisher server continues to answer calls.

Caution Do not restart the publisher server and do not switch to the upgraded software during this task. 
Otherwise, the Connection cluster will not function correctly.

5. Install the software upgrade on the subscriber server. See the applicable section:

• “Upgrading the Software from a Local DVD” section on page 11

• “Upgrading the Software from a Network Location” section on page 12

The subscriber server continues to answer calls.
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  Installation and Upgrade Information
Caution Do not restart the subscriber server and do not switch to the upgraded software during this 
task. Otherwise, the Connection cluster will not function correctly.

6. Switch to the upgraded software on the publisher server. See the “Switching to the Upgraded 
Software” section on page 14.

Messages may not be available while switching to the upgraded software. A few minutes after the 
subscriber server is switched to the upgraded software, messages are available.

7. Switch to the upgraded software on the subscriber server. See the “Switching to the Upgraded 
Software” section on page 14.

Messages may not be available while switching to the upgraded software. A few minutes after the 
subscriber server is switched to the upgraded software, messages are available.

8. About 15 minutes after you complete Task 7., on the publisher server, confirm that the publisher 
server has Primary status and that the subscriber server has Secondary status. For instructions, see 
the “Administering a Cisco Unity Connection Cluster” chapter of the Cluster Configuration and 
Administration Guide for Cisco Unity Connection Release 7.x.

9. On the subscriber server, confirm that the publisher server has Primary status and that the subscriber 
server has Secondary status. For instructions, see the “Administering a Cisco Unity Connection 
Cluster” chapter of the Cluster Configuration and Administration Guide for Cisco Unity Connection 
Release 7.x.

Downloading the Connection 7.0(2) Software for the Upgrade from 7.0(1)

Revised April 02, 2012
The upgrade application posted on Cisco.com can be used only to upgrade to Cisco Unity Connection 
7.0(2). It cannot be used to install a new Connection 7.0 system, or to migrate from Connection 1.x to 
7.0.

Because of the size of the upgrade application, the file has been divided into two parts. Do the following 
procedure to download the two parts and to recombine them into a single file.

To Download the Connection 7.0(2) Software for the Upgrade from 7.0(1)

Step 1 Log on to a computer with a high-speed Internet connection, and go to the Voice and Unified 
Communications Downloads page at 
http://tools.cisco.com/support/downloads/pub/Redirect.x?mdfid=278875240.

Note To access the software download page, you must be logged on to Cisco.com as a registered user.

Step 2 In the tree control on the Downloads page, expand , and click Cisco Unity Connection Version 7.0.

Step 3 On the Select a Software Type page, click Unity Connection Software.

Step 4 On the Select a Release page, click 7.0(2), and the download links appear on the right side of the page.

Step 5 Confirm that the computer you are using has sufficient hard disk space for the downloaded files. (The 
download file sizes appear below the download links.)

Step 6 Click UCSInstall_UCOS_7.0.2.10000-18.sgn.iso_part1, and follow the on-screen prompts to complete 
the download. Make note of the MD5 value. 
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  Installation and Upgrade Information
Step 7 Click UCSInstall_UCOS_7.0.2.10000-18.sgn.iso_part2, and follow the on-screen prompts to complete 
the download. Make note of the MD5 value. 

Step 8 For each downloaded file, use a checksum generator to confirm that the MD5 checksum matches the 
checksum that is listed on Cisco.com. If the values do not match, the downloaded file is damaged. 

Caution Do not attempt to use a damaged file to install software or the results will be unpredictable. 
If the MD5 values do not match, download the file again until the value for the downloaded 
file matches the value listed on Cisco.com. 

Free checksum tools are available on the Internet, for example, the Microsoft File Checksum Integrity 
Verifier utility. The utility is described in Microsoft Knowledge Base article 841290, Availability and 
Description of the File Checksum Integrity Verifier Utility. The KB article also includes a link for 
downloading the utility.

Step 9 Execute one of the following commands, depending on the operating system, to reunite the two parts of 
the file:

• On a Unix/Linux system, cut and paste the following command from this document into the CLI to 
combine the two files:

cat UCSInstall_UCOS_7.0.2.10000-18.sgn.iso_part1 UCSInstall_UCOS_7.0.2.10000-18.sgn.iso_part2 > 
UCSInstall_UCOS_7.0.2.10000-18.sgn.iso

• On a Windows system, cut and paste the following command from this document into the command 
prompt (cmd.exe) to combine the two files:

COPY /B UCSInstall_UCOS_7.0.2.10000-18.sgn.iso_part1+UCSInstall_UCOS_7.0.2.10000-18.sgn.iso_part2 
UCSInstall_UCOS_7.0.2.10000-18.sgn.iso

Step 10 If you are installing from a DVD, burn the DVD, noting the following considerations: 

• Choose the option to burn a disc image, not the option to copy files. Burning a disc image will extract 
the thousands of files from the .iso file that you created in Step 9 and write them to a DVD, which 
is necessary for the files to be accessible for the installation. 

• Use the Joliet file system, which accommodates filenames up to 64 characters long. 

• If the disc-burning application that you are using includes an option to verify the contents of the 
burned disc, choose that option. This causes the application to compare the contents of the burned 
disc with the source files. 

Step 11 Confirm that the DVD contains a large number of directories and files, not just the .iso file that you 
created in Step 9. 

Step 12 Delete unnecessary files from the hard disk to free disk space, including the two .iso files that you 
downloaded and the combined .iso file that you created in Step 9. 

Upgrading the Software from a Local DVD

To Upgrade the Software from a Local DVD

Step 1 Insert the DVD into the disc drive on the Cisco Unity Connection server.

Step 2 Log on to Cisco Unified Operating System Administration.

Step 3 From the Software Upgrades menu, click Install/Upgrade.
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  Installation and Upgrade Information
Step 4 On the Software Installation/Upgrade page, in the Source field, click DVD/CD.

Step 5 In the Directory field, enter a forward slash (/).

Step 6 Click Next.

Step 7 Select the upgrade version that you want to install and click Next.

Step 8 On the next page, monitor the progress of the upgrade.

Note If you close your browser during this step, you may see the following message when you try to 
view the Software Installation/Upgrade page again:

Warning: Another session is installing software, click Assume Control to take over the 
installation.

To continue monitoring the upgrade, click Assume Control.

You can also monitor the upgrade by using the Real-Time Monitoring Tool.

Step 9 Select the applicable restart action, depending on the configuration:

Step 10 Click Next.

Step 11 If you selected the Reboot to Upgrade Partition option in Step 9, the Connection server restarts and 
switches to the upgraded software.

Note You can check the status of the installation of the upgrade software by using the show cuc 
version command in the command-line interface (CLI). The installation is complete when the 
inactive partition has the upgraded software and the active partition has the old software.

If you selected the Do Not Reboot After Upgrade option, click Finish when the installation of the 
upgrade software is complete. The Upgrade Status window displays the Upgrade log. 

Upgrading the Software from a Network Location

Do the following procedure to upgrade the software from a network location or from a remote server.

To Upgrade the Software from a Network Location

Step 1 Copy the upgrade file to a directory on an FTP or SFTP server that the Cisco Unity Connection server 
can access.

No Connection cluster • To install the upgrade software and automatically restart to the 
upgraded partition, click Reboot to Upgraded Partition.

• To install the upgrade and restart to the upgraded partition at a later 
time, click Do Not Reboot After Upgrade.

Connection cluster configured Click Do Not Reboot After Upgrade.
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  Installation and Upgrade Information
Step 2 Log on to Cisco Unified Operating System Administration.

Step 3 From the Software Upgrades menu, click Install/Upgrade.

Step 4 On the Software Installation/Upgrade page, in the Source field, click Remote Filesystem.

Step 5 In the Directory field, enter the path to the directory that contains the upgrade file.

If the upgrade file is located on a Linux or Unix server, you must enter a forward slash (/) at the beginning 
of the directory path. (For example, if the upgrade file is in the upgrade directory, you must enter 
/upgrade.)

If the upgrade file is located on a Windows server, you must use the applicable syntax for an FTP or 
SFTP server such as:

• The path must begin with a forward slash (/) and contain forward slashes throughout instead of 
backward slashes (\).

• The path must start from the FTP or SFTP root directory on the server and must not include a 
Windows absolute path, which starts with a drive letter (for example, C:).

Step 6 In the Server field, enter the server name or IP address.

Step 7 In the User Name field, enter the username that will be used to log on to the remote server.

Step 8 In the User Password field, enter the password that will be used to log on to the remote server.

Step 9 In the Transfer Protocol field, select the applicable transfer protocol.

Step 10 Click Next.

Step 11 Select the upgrade version that you want to install and click Next.

Step 12 On the next page, monitor the progress of the upgrade.

Note If you lose your connection with the remote server or close your browser during this step, you 
may see the following message when you try to view the Software Installation/Upgrade page 
again:

Warning: Another session is installing software, click Assume Control to take over the 
installation.

To continue monitoring the upgrade, click Assume Control.

You can also monitor the upgrade by using the Real-Time Monitoring Tool.

Step 13 Select the applicable restart action, depending on the configuration:

Step 14 Click Next.

Step 15 If you selected the Reboot to Upgrade Partition option in Step 13, the Connection server restarts and 
switches to the upgraded software.

No Connection cluster • To install the upgrade software and automatically restart to the 
upgraded partition, click Reboot to Upgraded Partition.

• To install the upgrade and restart to the upgraded partition at a later 
time, click Do Not Reboot After Upgrade.

Connection cluster configured Click Do Not Reboot After Upgrade.
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Note You can check the status of the installation of the upgrade software by using the show cuc 
version command in the command-line interface (CLI). The installation is complete when the 
inactive partition has the upgraded software and the active partition has the old software.

If you selected the Do Not Reboot After Upgrade option, click Finish when the installation of the 
upgrade software is complete. The Upgrade Status window displays the Upgrade log. 

Switching to the Upgraded Software

To Switch to the Upgraded Software

Step 1 Log on to Cisco Unified Operating System Administration.

Step 2 From the Settings menu, click Version.

Step 3 On the Version Settings page, click Switch Versions.

The Connection server restarts and switches to the upgraded software.

Note You can check the status of the installation of the upgrade software by using the show cuc 
version command in the command-line interface (CLI). The installation is complete when the 
inactive partition has the upgraded software and the active partition has the old software.

Upgrading from Cisco Unity Connection 2.x to 7.0(2)

Caution If any languages other than U.S. English (ENU) are currently installed and in use on the Cisco Unity 
Connection 2.x system, you must install the Connection 7.0 versions of the same languages during the 
upgrade. Otherwise, the Connection conversation will not function properly for users who are configured 
to use non-ENU languages. For information on downloading and installing languages, see the 
“Downloading and Installing Cisco Unity Connection Languages” section on page 16. 

A change that was made to Connection in version 2.1(3) prevents upgrades from version 2.1(3) to 
Connection 7.0(1) or 7.0(2). To upgrade from Connection 2.1(3), you will need to wait for Connection 
7.1(2) to be released, in the second quarter of 2009.

For instructions on downloading software that can be used to upgrade a Connection 2.x system to version 
7.0, see “Downloading the Connection 7.0(2) Software for the Upgrade from 2.x” section on page 15.

For instructions on upgrading a Connection 2.x system to version 7.0, see the “Upgrading Cisco Unity 
Connection 2.x or Later to the Shipping 7.x Version” chapter of the Reconfiguration and Upgrade Guide 
for Cisco Unity Connection Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/upgrade/guide/7xcucrugx.html.
14
Release Notes for Cisco Unity Connection Release 7.0(2)

OL-18980-01

http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/upgrade/guide/7xcucrugx.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/upgrade/guide/7xcucrug010.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/upgrade/guide/7xcucrug010.html


  Installation and Upgrade Information
Downloading the Connection 7.0(2) Software for the Upgrade from 2.x

Revised 02 April 2012
The upgrade application posted on Cisco.com can be used only to upgrade to Cisco Unity Connection 
7.0(2). It cannot be used to install a new Connection 7.0 system, or to migrate from Connection 1.x to 
7.0.

Because of the size of the upgrade application, the file has been divided into two parts. Do the following 
procedure to download the two parts and to recombine them into a single file.

To Download the Connection 7.0(2) Software for the Upgrade from 2.x

Step 1 Log on to a computer with a high-speed Internet connection, and go to the Voice and Unified 
Communications Downloads page at 
http://tools.cisco.com/support/downloads/pub/Redirect.x?mdfid=278875240.

Note To access the software download page, you must be logged on to Cisco.com as a registered user.

Step 2 In the tree control on the Downloads page, expand Products>Voice and Unified Communications>IP 
Telephony>Unified Messaging>Cisco Unity Connection, and click Cisco Unity Connection Version 
7.0.

Step 3 On the Select a Software Type page, click Unity Connection Software.

Step 4 On the Select a Release page, click 7.0(2), and the download links appear on the right side of the page.

Step 5 Confirm that the computer you are using has sufficient hard disk space for the downloaded files. (The 
download file sizes appear below the download links.)

Step 6 Click UCSInstall_UCOS_7.0.2.10000-18.sgn.iso_part1of2, and follow the on-screen prompts to 
complete the download. Make note of the MD5 value. 

Step 7 Click UCSInstall_UCOS_7.0.2.10000-18.sgn.iso_part2of2, and follow the on-screen prompts to 
complete the download. Make note of the MD5 value. 

Step 8 For each downloaded file, use a checksum generator to confirm that the MD5 checksum matches the 
checksum that is listed on Cisco.com. If the values do not match, the downloaded file is damaged. 

Caution Do not attempt to use a damaged file to install software or the results will be unpredictable. 
If the MD5 values do not match, download the file again until the value for the downloaded 
file matches the value listed on Cisco.com. 

Free checksum tools are available on the Internet, for example, the Microsoft File Checksum Integrity 
Verifier utility. The utility is described in Microsoft Knowledge Base article 841290, Availability and 
Description of the File Checksum Integrity Verifier Utility. The KB article also includes a link for 
downloading the utility.

Step 9 Execute one of the following commands, depending on the operating system, to reunite the two parts of 
the file:

• On a Unix/Linux system, cut and paste the following command from this document into the CLI to 
combine the two files:

cat UCSInstall_UCOS_7.0.2.10000-18.sgn.iso_part1of2 UCSInstall_UCOS_7.0.2.10000-18.sgn.iso_part2of2 > 
UCSInstall_UCOS_7.0.2.10000-18.sgn.iso
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  Installation and Upgrade Information
• On a Windows system, cut and paste the following command from this document into the command 
prompt (cmd.exe) to combine the two files:

COPY /B UCSInstall_UCOS_7.0.2.10000-18.sgn.iso_part1of2+UCSInstall_UCOS_7.0.2.10000-18.sgn.iso_part2of2 
UCSInstall_UCOS_7.0.2.10000-18.sgn.iso

Step 10 If you are installing from a DVD, burn the DVD, noting the following considerations: 

• Choose the option to burn a disc image, not the option to copy files. Burning a disc image will extract 
the thousands of files from the .iso file that you created in Step 9 and write them to a DVD, which 
is necessary for the files to be accessible for the installation. 

• Use the Joliet file system, which accommodates filenames up to 64 characters long. 

• If the disc-burning application that you are using includes an option to verify the contents of the 
burned disc, choose that option. This causes the application to compare the contents of the burned 
disc with the source files. 

Step 11 Confirm that the DVD contains a large number of directories and files, not just the .iso file that you 
created in Step 9. 

Step 12 Delete unnecessary files from the hard disk to free disk space, including the two .iso files that you 
downloaded and the combined .iso file that you created in Step 9. 

Migrating from Cisco Unity or from Cisco Unity Connection 1.x to Cisco Unity 
Connection 7.0

For information on migrating from Cisco Unity 4.0(5) or later to Connection 7.0 or from Connection 1.x 
to Connection 7.0, see the applicable migrating chapter of the Reconfiguration and Upgrade Guide for 
Cisco Unity Connection Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/upgrade/guide/7xcucrugx.html.

Installation and Upgrade Notes
• Downloading and Installing Cisco Unity Connection Languages, page 16

• License Tag Required to Use the U.S. English Conversation and Personal Call Transfer Rules, 
page 18

Downloading and Installing Cisco Unity Connection Languages

Revised September 1, 2009
You need to download and install Connection 7.0 languages in the following situations:

• If you are installing a new Connection 7.0(2) system.

• If you are adding languages to an existing Connection 7.0 system.

• If you are upgrading from Connection 2.x or Cisco Unified CMBE 6.x to 7.02.

(If you are upgrading from Connection 7.0(1) to 7.0(2), you do not need to download or install new 
languages. During the upgrade, the languages currently installed on the Connection 7.0(1) partition 
are automatically copied to the 7.0(2) partition.)
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Caution Depending on your license settings, you may not be allowed to use English-United States and, therefore, 
must install other languages for Cisco Unity Connection to function. For more information, see the 
“License Tag Required to Use the U.S. English Conversation and Personal Call Transfer Rules” section 
on page 18.

For language installation instructions, see the “Software Upgrades” chapter of the applicable guide:

• Cisco Unified Communications Operating System Administration Guide for Cisco Unity Connection 
Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/os_administration/guide/7xcuco
sagx.html.

• Cisco Unified Communications Operating System Administration Guide for Cisco Unified CMBE 
7.0 at http://www.cisco.com/en/US/products/ps7273/prod_maintenance_guides_list.html.

If you are installing Japanese because you want Cisco Unity Connection Administration to be localized, 
you must also install the Cisco Unified Communications Manager Japanese locale. See the “Locale 
Installation” section in the “Software Upgrades” chapter of the Cisco Unified Communications 
Operating System Administration Guide.

If you are installing other languages because you want the Cisco Personal Communications Assistant to 
be localized, you must also install the corresponding Cisco Unified Communications Manager locales. 
See the “Locale Installation” section in the “Software Upgrades” chapter of the Cisco Unified 
Communications Operating System Administration Guide.

To Download Cisco Unity Connection Languages

Step 1 On a computer with a high-speed Internet connection, go to the Voice and Unified Communications 
Downloads page at http://tools.cisco.com/support/downloads/pub/Redirect.x?mdfid=278875240.

Note To access the software download page, you must be logged on to Cisco.com as a registered user.

Step 2 In the tree control on the Downloads page, expand Products>Voice and Unified Communications>IP 
Telephony>Unified Messaging>Cisco Unity Connection, and click Cisco Unity Connection Version 
7.0.

Step 3 On the Select a Software Type page, click Cisco Unity Connection Locale Installer.

Step 4 On the Select a Release page, click 7.0(1), and the download links appear on the right side of the page.

Note Connection 7.0(1) language files are also used with version 7.0(2).

Step 5 Confirm that the computer you are using has sufficient hard disk space for the downloaded files. (The 
download file sizes appear below the download links.)

The filename for each language is uc-locale-<two-letter language abbreviation>_<two-letter country 
abbreviation>-<version>.cop.sgn. 

Step 6 Click the name of a file to download.

Step 7 On the Download Image page, make note of the MD5 value.

Step 8 Follow the on-screen prompts to complete the download. 

Step 9 Repeat Step 6 through Step 8 for each Connection language that you want to install. 
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Note You can install up to five languages on a Connection server. 

Step 10 For each downloaded file, use a checksum generator to confirm that the MD5 checksum matches the 
checksum that is listed on Cisco.com. If the values do not match, the downloaded file is damaged. 

Caution Do not attempt to use a damaged file to install software or the results will be unpredictable. 
If the MD5 values do not match, download the file again until the value for the downloaded 
file matches the value listed on Cisco.com.

Free checksum tools are available on the Internet—for example, the Microsoft File Checksum Integrity 
Verifier utility. The utility is described in Microsoft Knowledge Base article 841290, Availability and 
Description of the File Checksum Integrity Verifier Utility. The KB article also includes a link for 
downloading the utility.

Step 11 Either copy the downloaded files to an FTP or SFTP server, or burn the files to CDs or DVDs. If you 
burn discs of the files, note the following considerations:

• Use the Joliet file system, which accommodates filenames up to 64 characters long.

• If the disc-burning application that you are using includes an option to verify the contents of the 
burned disc, choose that option. This causes the application to compare the contents of the burned 
disc with the source files.

• Label the discs “Cisco Unity Connection 7.0(1) languages.”

Step 12 Delete the downloaded files to free disk space.

License Tag Required to Use the U.S. English Conversation and Personal Call Transfer Rules

If you want to use English-United States for the Cisco Unity Connection conversation or you want users 
to be able to create personal call transfer rules, the Connection license must include the license tag 
LicRegionIsUnrestricted. If your Connection licenses do not include the LicRegionIsUnrestricted tag 
and you want to use these features, install a license that includes the tag. After you install the license, 
you must restart Connection. (Licenses without this tag are intended only for use outside the United 
States.)

If you choose not to install a license that includes the LicRegionIsUnrestricted tag, you must install one 
or more Connection languages. 

Connection demonstration licenses include the LicRegionIsUnrestricted tag, so you can use 
English-United States on demonstration systems. 

To Determine Whether the LicRegionIsUnrestricted License Tag Is Present 

Step 1 In Cisco Unity Connection Administration, under System Settings, click Licenses. 

Step 2 On the Licenses page, click the name of the first license file. 

Step 3 On the View License page, in the File Content box, search for the text “LicRegionIsUnrestricted.” 

Step 4 If you do not find the text in the first file, search all of the other license files listed on the Licenses page. 
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Step 5 If “LicRegionIsUnrestricted” does not appear in any of the license files, get a license that contains the 
tag before you install Connection. 

Important Notes

Connection IMAP Server Service Should Not Be Stopped or Disabled For An 
Extended Period of Time

Added October 19, 2010
The Connection IMAP Server service processes events that are placed in the IMAP queue table in the 
Connection database when voice messages are created, updated, or deleted, even if you do not have 
active IMAP users. If the service is disabled or stopped, the table continues to grow, and can eventually 
fill available disk space and cause database instability. Do not stop the service for more than a day at a 
time or disable the service indefinitely. If you have previously stopped or disabled the service, try 
restarting the service. If the service does not start, contact Cisco TAC to apply the workaround for caveat 
CSCti68395.

Limitations and Restrictions

Connection Cannot Be Installed or Operated in IPv6 or Dual-Stack (IPv4 and 
IPv6) Networks

Revised November 9, 2010
Connection 7.0 does not support IPv6, and cannot be installed or operated in a pure IPv6 network. To 
install or operate in a dual-stack (IPv4 and IPv6) network, a workaround for CSCtj93659 is required. See 
the caveat information for CSCtj93659 for more details.

Media Master Cannot Open WAV Files Saved on a Workstation in G.729a 
Format

The Media Master cannot open WAV files prerecorded in the G.729a audio format and saved to a 
workstation.

This limitation has the following workarounds:

• Convert the WAV file to another audio format (for example, convert it to the G.711 audio format).

• Use a WAV file that is recorded in a supported audio format other than G.729a.

• Make the recording by using a phone or a computer microphone.

Note that when Cisco Unity Connection is configured to record in the G.729a audio format, the Media 
Master functions correctly for recording and playing by using a phone or a computer microphone.
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Replacing Disks in a RAID 
Connection supports only replacing a defective disk in a RAID with a blank disk to repair the RAID. 
Replacing disks in a RAID for any other reason is not supported. 

Caution Do not replace a disk in a RAID with a disk that contains data, even if the replacement disk was 
originally a disk in the same RAID in the same server. 

ViewMail Limitations Regarding Secure Messages
Added February 22, 2010

• Secure messages cannot be forwarded by using Cisco Unity Connection ViewMail for Microsoft 
Outlook or ViewMail for IBM Lotus Notes.

• ViewMail for Outlook and ViewMail for Notes support only playing secure messages.

• Messages that are composed or replied to by using ViewMail for Outlook or ViewMail for Notes are 
not sent as secure, even when users are assigned to a class of service for which the Require Secure 
Messaging field is set to Always or to Ask.

Caveats
The tables in this section list any Severity 1, 2, and 3 caveats when Cisco Unity Connection 7.0(2) was 
released.

You can find the latest caveat information for Cisco Unity Connection version 7.0(2) and for Connection 
in Cisco Unified Communications Manager Business Edition version 7.0(2)—in addition to caveats of 
any severity for any release—by using Bug Toolkit, an online tool available for customers to query 
defects according to their own needs. Bug Toolkit is available at http://www.cisco.com/go/bugs.

Note To access Bug Toolkit, you must be logged on to Cisco.com as a registered user.

This section contains caveat information for Cisco Unity Connection 7.0(2) and Connection in Cisco 
Unified CMBE 7.0(2) only. Refer to the release notes of the applicable version for caveat information 
for earlier versions of Cisco Unity Connection.

Release notes for all versions of Cisco Unity Connection are available at 
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html. 

Release notes for all versions of Cisco Unified Communications Manager Business Edition are available 
at http://www.cisco.com/en/US/products/ps7273/prod_release_notes_list.html.

Open Caveats—Connection Release 7.0(2), and Connection in Cisco 
Unified CMBE Release 7.0(2)

Click a link in the Caveat Number column to view the latest information on the caveat in Bug Toolkit. 
(Caveats are listed in order by severity, then by component, then by caveat number.)
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Table 1 Connection Release 7.0(2) and Connection in Cisco Unified CMBE 7.0(2) Open Caveats

Caveat Number Component Severity Description

CSCsr42066 admin 3 A/A: After SBR can't login to the secondary node using web page.

CSCsu89086 admin 3 PCA throws ???en_US.Too recently used Credential???

CSCsw23456 admin 3 CUAdmin:imported greetings of 90 secs' length not playable via CUAdmin

CSCsw73317 admin 3 SA page issue: URL sometimes shows up in main window

CSCsw83409 admin 3 SA Login Fail with Exception Authenticating user

CSCsw97884 admin 3 CSV Headers and imported values do not match displayed search row

CSCsv42398 api 3 VMWS callerName not always available for voicemail users

CSCsv69240 api 3 StopPosMs of 536867912 returned from Record method

CSCsw24633 api 3 Hangup Call VMWS fails for SIP phones

CSCsw70788 api 3 Get INVALID_INPUT after skipping to another part of a message

CSCsw86682 api 3 Midlet files should be in their own folder under tomcat

CSCso69745 conversations 3 VUI doesn't identify target when asking for device confirmation

CSCsr42373 conversations 3 TUI doesn't obey Send NDR on Failed Message Delivery setting

CSCsr97247 conversations 3  Intermittent core dumps in greeting administrator conversation

CSCsu38511 conversations 3 System Default TTS Language setting has No TTS effect

CSCsv38097 conversations 3 Toggle Urgency isn't voiced in After Message Menu

CSCsx01885 conversations 3 APL: Addressing by extension does not invoke addressing priority list

CSCsi67479 core 3 JPN:Reports: Japanese are garbled in csv file

CSCso63423 core 3 CPCA: Cannot delete rule set

CSCsr02085 core 3 DN: Private list undeliverable with global remote user

CSCsr47650 core 3 DSS: Allow selecting a search space for the Dial Search Scope report

CSCsr47651 core 3 DSS: Dial Search Scope report should report on all DAOs

CSCsr63851 core 3 Reports to continue or cancel request show ???report.confirm.title?

CSCsr68377 core 3 Reports not working with very large database

CSCsr01255 database 3 Core dump in Unityconnection during loadrun

CSCsr47381 database 3 A/A : Alias Conflicts During Split Brain

CSCsr49610 database 3 Http Error while trying to edit subscriber password

CSCsu31649 database 3 Problem with syncing a greeting stream file in a Cluster

CSCsu85394 database 3 csp_NotificationMWI procs have perf issues

CSCsv83379 database 3 DN: af Informix core observed when contact creation failed

CSCsw38722 database 3 Connection Database Proxy service doesn't stop when stopped via web page

CSCsw51579 database 3 Cannot add extensions to PIMG ports

CSCsk08289 localization 3 JPN: English strings remain in CUC Admin pages

CSCsr40660 localization 3 JPN: VMO Vista OL 2007 cannot read VMO addin

CSCsr75682 localization 3 Errornous Japanese prompts for Personal Call Transfer Rule settings

CSCsu36037 localization 3 It showed Complete in Status under OS Platform upgrade page.
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http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw73317
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw83409
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw97884
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv42398
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv69240
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw24633
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw70788
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw86682
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso69745
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr42373
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr97247
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu38511
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv38097
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsx01885
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi67479
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso63423
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr02085
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr47650
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr47651
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr63851
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr68377
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr01255
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr47381
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr49610
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu31649
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu85394
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv83379
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw38722
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw51579
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsk08289
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr40660
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr75682
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu36037


  Caveats
Resolved Caveats—Connection Release 7.0(2), and Connection in Cisco 
Unified CMBE Release 7.0(2)

Click a link in the Caveat Number column to view the latest information on the caveat in Bug Toolkit. 
(Caveats are listed in order by severity, then by component, then by caveat number.)

CSCsk13010 mediamaster 3 "hang up in trap, then quickly initiate another trap session, plays again"

CSCsr19015 messaging 3 Lotus Note 7.0 running hangs on the folder update view

CSCsr19050 messaging 3 "Lotus Note all versions fail when ""sending"" email using 
UntiyConnection"

CSCsr28895 messaging 3 "Lotus Note 8.5 running on Mac crashed after the ""send"" email action"

CSCsr42543 messaging 3 A/A: In Split Brain CUCA allows us to delete a mailstore

CSCsr46932 messaging 3 Eudora Inbox failed to dsplay the new email after voice mail deleted it

CSCsu55797 messaging 3 Can't login from IMAP client if alias & local-part of SMTP addr differs

CSCsm81788 ossetup 3 UC 7 upgrade should check for disk space prior to upgrade

CSCsm69727 reports 3 User Message Activity Report spikes CPU for long time when run w/default

CSCsr45007 reports 3 Subscriber Message Activity report problems

CSCsw31464 setup 3 Reduced ES upgrade is missing RPMs that include code changes

CSCsw85509 setup 3 7845 can fail version switch due to missing bind mount

CSCso07071 telephony 3 Incorrect caller name played when call transferred to connection

CSCsr54216 telephony 3 Media fails reading localized text in UTF-8

CSCsw82780 telephony 3 """Stop taking calls"" button should stop responding to OPTIONS request"

CSCsr90132 vmo 3 "VMO: In Outlook2007, VMO form is removed when we save the Msg"

CSCsu55499 vmo 3 "After install of VMO, the 1st voice msg received doesn't have VMO form"

CSCsu58608 vmo 3 "VMO: For OL 2007, info under Server tab of VMO Options always blank"

CSCsu60031 vmo 3 VMO: Error msg for each start of Outlook 2007 after un-install of VMO

CSCsw38665 vmo 3 VMO: Error starting Outlook2007 when a different user try load outlook

CSCsr30437 vui 3 CC: VUI user can't access VPIM contact

Table 1 Connection Release 7.0(2) and Connection in Cisco Unified CMBE 7.0(2) Open Caveats (continued)

Caveat Number Component Severity Description

Table 2 Connection Release 7.0(2) and Connection in Cisco Unified CMBE 7.0(2) Resolved Caveats

Caveat Number Component Severity Description

CSCsv83436 admin 1 CUCMBE Switching version corrupt/delete /usr/local/cm/bin/ccm

CSCsv30555 api 1 VMWS: axis2 admin service exposed with default credentials

CSCsv74017 api 1 Login doesn't check alternate extensions

CSCsw88735 admin 2 CuCsMgr crash

CSCsx32971 admin 2 UC7.0:Not able to login to RTMT and Serviceability pages broken

CSCsq99033 api 2 VMWS - No MailboxStatus filter for getMessageCounts
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http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsk13010
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr19015
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr19050
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr28895
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr42543
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr46932
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu55797
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsm81788
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsm69727
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr45007
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw31464
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw85509
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso07071
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr54216
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw82780
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr90132
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu55499
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu58608
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu60031
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw38665
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr30437
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv83436
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv74017
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv30555
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsx32971
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw88735
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq99033


  Caveats
CSCsq99148 api 2 VMWS - Error when calling placeCall method

CSCsq99172 api 2 "VMWS - ""Cannot get a connection, pool exhausted"" on Login"

CSCsq99204 api 2 VMWS - Need Connection Support for Reverse TRAP

CSCsq99214 api 2 VMWS - Priovide TUI Pilot number as Login Property

CSCsr03821 api 2 VMWS - SetMessageProps returns INVALID_INPUT

CSCsr11233 api 2 VMWS UrgVoiceFirst Filter returns incorrect data for getMessages

CSCsr11390 api 2 "VMWS - StopPosMs, PlayTimeMs, TermReason values are 0 in Play 
Response"

CSCsr11428 api 2 VMWS - java.lang.NoSuchMethodError returned from SetMessageProps

CSCsr13771 api 2 "VMWS - Record returns after 20s with no response, record beep not 
heard"

CSCsr14396 api 2 VMWS - PasswordExpired SOAP Fault prevents TUI Redirection

CSCsr41545 api 2 VMWS: Need Admin UI Change for VMWS Reverse Pilot Number

CSCsr55633 api 2 VMWS - GetMessageAddressInfo not implemented

CSCsr55931 api 2 VMWS - Playing a forwarded message results in Termination code 19

CSCsr65534 api 2 VMWS - GetMessageCounts returns incorrect values

CSCsr89120 api 2 VMWS - ForwardMessage with Null RecordId causes INVALID_INPUT

CSCsr96089 api 2 VMWS - GetMessages does not obey the Max parameter

CSCsr96099 api 2 "VMWS - Play a Forwarded message, only the intro is played"

CSCsu45388 api 2 UC 7.0(1): Partner Server detail not presented in LoginResponse

CSCsu45469 api 2 Duration of message intermittently incorrect

CSCsu47176 api 2 issues with silence and Record method

CSCsu47458 api 2 Intermittently Play request returns immediately

CSCsu77046 api 2 Searching for a distribution list causes an empty response

CSCsu81798 api 2 SendMessage with Distribution list objectID causes error

CSCsu82015 api 2 Maximum recording time is 30 seconds

CSCsv07251 api 2 VMWS: Invalid soap fault thrown on Record when mailbox is full.

CSCsu01319 database 2 "Unity connection SMTP address replacing ""."" with ""_"""

CSCsu99203 database 2 Reverse Trap Pilot is replicated between cluster nodes

CSCsv70640 database 2 CUALS should lower case of alias when checking privileges on both sides

CSCsv77647 database 2 Unable to modify PIMG ports in an active/active cluster

CSCsv83807 database 2 UC 7: Hostname Change Fails due to Informix not being fully online

CSCsw14902 database 2 "install fails with database error when no DNS and domain name has no 
""."""

CSCsw83747 database 2 UC 7.0 - SMTP Domain Change Breaks External Voice Mail Message 
Delivery

Table 2 Connection Release 7.0(2) and Connection in Cisco Unified CMBE 7.0(2) Resolved Caveats (continued)

Caveat Number Component Severity Description
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http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv07251
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu82015
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu81798
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu77046
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu47458
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu47176
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu45469
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu45388
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr96099
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr96089
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr89120
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr65534
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr55931
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr55633
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr41545
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr14396
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr13771
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr11428
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr11390
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr11233
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr03821
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq99214
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq99204
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq99172
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq99148
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw83747
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw14902
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv83807
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv77647
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv70640
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu99203
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu01319


  Caveats
CSCsx32588 database 2 UC7 DynDb:tbl_DbEventQ fills up- causes failsafe and other bad 
behaviour

CSCsu21705 messaging 2 DN: Sub-object replication fails intermittently.

CSCsv13131 messaging 2 Unity Connection forwarded messages via VPIM to 3rd party system fails

CSCsx15622 messaging 2 DN: A pause event interrupt is sometimes missed by the running thread

CSCsu40200 mixer 2 CuMixer Core dumps on long run.

CSCsu21665 pca 2 Unity Connection message failing to play with phone option over PCA

CSCsr83757 telephony 2 ASA blocks skinny registration message if inspect turned on.

CSCsu50138 telephony 2 SIP: Core dump when breaking down KPML subscriptions

CSCsv02232 telephony 2 UC 7.0 does not register correctly to CCM with NFT enabled

CSCsq21618 admin 3 If cluster nodes cant connect disable ports status for that node

CSCsr26274 admin 3 BAT does not export contacts vui dialable numbers

CSCsr60804 admin 3 need a way to clean out badmail folder without root access

CSCsu68074 admin 3 Security issue allows for admins to read files on the hard drive

CSCsu68536 admin 3 Forward Routing Rules missing some rule conditions

CSCsu80905 admin 3 Only first 5 ports are available for port based direct routing rule

CSCsv80210 admin 3 Cannot send message from PCA after Replace Tomcat Cert

CSCsw75701 admin 3 No License data sync across cluster without reboot/lic service restart

CSCsx07740 admin 3 Bulk Edit: Message Actions changed to Reject the message

CSCsx18642 admin 3 Smtp Server Core dump

CSCsx32921 admin 3 UC7.0: RTMT Plugin download link broken

CSCsq99118 api 3 VMWS - To/From in getMessages contains emailaddress

CSCsq99131 api 3 VMWS - E_VMWS_GEN_SESSION_EXPIRED returned from 
getMessages

CSCsr11341 api 3 VMWS - RenewLogin does not return status value

CSCsr11444 api 3 VMWS - Play with Speed value 200 does not play message at double 
speed

CSCsr11620 api 3 VMWS - CallerId and CallerName fields return 0 and 'none'

CSCsr16181 api 3 VMWS - No AccountStatus set for Broadcast Message

CSCsr16375 api 3 VMWS - Add Setting for Client Credential Caching

CSCsr55606 api 3 VMWS - FromSub Message property always returns true

CSCsr86235 api 3 VMWS - Partner Server Login Prop is 127.0.0.1

CSCsr86560 api 3 VMWS - Send does not mark msg as Urgent / Private when specified

CSCsu07968 api 3 Add AddressInfoID as Login property

CSCsu42049 api 3 GetMessageAddressInfo does not work for multiple recipients

CSCsu42070 api 3 SearchRecipient does not return correct error when matches > 25

CSCsu42079 api 3 PasswordCacheEnabled is opposite of what it should be

Table 2 Connection Release 7.0(2) and Connection in Cisco Unified CMBE 7.0(2) Resolved Caveats (continued)

Caveat Number Component Severity Description
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http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsx32588
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsx15622
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv13131
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu21705
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu40200
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu21665
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv02232
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu50138
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr83757
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsx32921
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsx18642
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsx07740
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsw75701
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsv80210
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu80905
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu68536
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu68074
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr60804
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr26274
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq21618
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu42079
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu42070
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu42049
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsu07968
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr86560
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr86235
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr55606
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr16375
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr16181
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr11620
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr11444
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsr11341
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq99131
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq99118


  Caveats
CSCsu42083 api 3 isConnected returns SOAP fault on invalid call ID

CSCsu47517 api 3 Message played from start when startPos equals message duration

CSCsu52312 api 3 VMWS - StopPosMs is incorrectly factored by play speed.

CSCsu63194 api 3 ForwardMessage not working when recordId is NULL

CSCsu63323 api 3 Ports locked while running VMWS test

CSCsu70145 api 3 VMWS: ReplyMessage api not working

CSCsu87639 api 3 VMWS:Duplicate sessions IDs

CSCsv09177 api 3 VMWS : Send api not working

CSCsv10037 api 3 VMWS: New Message Count inludes Read Receipts

CSCsw51965 api 3 VMWS: MaxMsgLength property is returned in milliseconds instead of 
sec

CSCsw86682 api 3 Midlet files should be in their own folder under tomcat

CSCsv95116 backup 3 Clustering Install fails After Server replacement

CSCsv40326 config 3 UC 7 install crashes when hostname is too short

CSCsr14271 conversations 3 VMWS - No Timeout on Reverse Trap call when no callID Digits sent

CSCsv89595 conversations 3 Idle Trap call does not timeout until after a message is played

CSCsx02684 conversations 3 Blind addresses are returned before user matches

CSCsr56999 core 3 State information is getting overwritten by replication somehow

CSCsr92677 core 3 Report Query somtimes fails on A/A setup

CSCsu36266 core 3 Connection should not restart RIS DC during upgrade

CSCsu88911 core 3 CuCsMgr core dump during VMWS load

CSCsu90734 core 3 "VMWS: CuCsMgr core dump , CCsTrapCall::Play"

CSCsv65731 core 3 CUC - Web Sessions counters missing in perfctr.xml

CSCsv92357 core 3 UC 7.0 some scheduled tasks do not run.

CSCse11067 database 3 SA: Cannot modify user's alias with special chars

CSCsr05155 database 3 UC should display aliases in the case entered

CSCsr81604 database 3 No task definition in CUCA Task Management after upgrade from 2.1

CSCsr89940 database 3 Switchover fails if publisher is restored from subscriber

CSCsu05112 database 3 "Create/Edit User,Contact,SysDistList ->""not a valid SMTP address"""

CSCsu57156 database 3 DN: Unable to join UC 7.X nodes in a digitally networked environment.

CSCsu63587 database 3 DN: Location remove fails if call handler template reference remote user

CSCsu68091 database 3 security issue allows some lesser admins to escalate priviliges

CSCsu92680 database 3 After ES upgrade Reverse Trap Number is Deleted

CSCsu98521 database 3 Australian Daylight Saving : Changes in October

CSCsv34676 database 3 Upgrade script doesn't update the SystemVersion.

CSCsv47103 database 3 Missing lines in secondary A/A license cause SA problems

Table 2 Connection Release 7.0(2) and Connection in Cisco Unified CMBE 7.0(2) Resolved Caveats (continued)
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CSCsv64328 database 3 Message Actions relay address formula uses wrong extension

CSCsv65196 database 3 Connection 7.0 subscriber with similar name to pub won't install

CSCsx15305 database 3 Only first 50 forwarded call routing rules work

CSCsu11936 messaging 3 "Can not send SMTP NTFY: 553 5.0.0 Header error, Invalid Message ID"

CSCsu42456 messaging 3 Messages left via VPIM are not relayed per Message Action

CSCsu55797 messaging 3 Can't login from IMAP client if alias & local-part of SMTP addr differs

CSCsw26334 messaging 3 DN: High CPU on 7835s when other new nodes being added

CSCsw87071 messaging 3 SSLV2 connection to IMAP need be disabled

CSCso21049 mixer 3 """Popping sounds"" audible on endpoint when g.722 negotiated"

CSCsr81610 mixer 3 Offline transcoding G729 message to other codec causes garbled audio

CSCsu67422 mixer 3 g726 not setting fact chunk properly in wav file

CSCsu72289 mixer 3 transcoding to/from g726 has occasional clipping

CSCsl80634 pca 3 ARA: CPCA display issues in Arabic UI

CSCsr58274 pca 3 PCA gives error when playing back messages stored in G.729a

CSCsw33324 pca 3 CPCA : Java Error pop-up when running JRE6 on a client PC

CSCsx18636 pca 3 PCA feature doesn’work correctly if Java isn’loaded

CSCse19688 reports 3 Reports: long object name is truncated

CSCsi52226 reports 3 Call handler link on reports gives 404

CSCsw85509 setup 3 7845 can fail version switch due to missing bind mount

CSCsx34492 setup 3 script kept hunging during upgrade / switch version

CSCsu54510 telephony 3 offline transcoding lib needs better validation logic

CSCsv15955 telephony 3 No recording is accepted when sending a or replying to a message

CSCsw44020 telephony 3 re-establishing SRTP media to new ep fails

CSCsw67507 telephony 3 Mixer is arbitrarily capping message trim limit at 300 ms.

CSCsu61487 vmo 3 VMO: Voice msg sent from VMO recorded via phone can't be played

CSCsv31962 admin 4 Configured Language needs to be selected by default in Media master

CSCsv59341 admin 4 Bulkedit has 9 digit maxlength for extension range on search

CSCsw70471 admin 4 Restriction Table Ordering page does not always sort correctly

CSCsu92486 api 4 add handling for Tomcat up and backend services down

CSCsw19807 api 4 getSpeed does not match User's Playback Speed Setting

CSCsl57953 core 4 Reports: List DL members in any DL report causes NULL Creation Time

CSCsr28740 core 4 email address field shows extra string when import contact from 
Exchange

CSCsv39967 core 4 Fix CML unit test scripts to accomodate recent db changes.

CSCsu79857 database 4 CuFileSync could crash due to signal handling

CSCsu79909 database 4 Future delivery message files not replicated

Table 2 Connection Release 7.0(2) and Connection in Cisco Unified CMBE 7.0(2) Resolved Caveats (continued)
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Documentation Updates

Errors
This section lists errors in the current documentation for Cisco Unity Connection and for Connection in 
Cisco Unified CMBE documentation and gives corrected information. The correct information will be 
incorporated in a future documentation release, or as otherwise noted.

Cisco Unified Serviceability Administration Guide Release 7.0(1): SNMP Traps and Informs

Added July 13, 2009
In the “SNMP Traps and Informs” section in the “Understanding Simple Network Management 
Protocol” chapter of the Cisco Unified Serviceability Administration Guide Release 7.0(1), the first note 
(after the first paragraph) should read as follows:

CSCsu79958 database 4 CuFileSync does not replicate deletes in subdirectories

CSCsv27811 database 4 Database needs to provide transfer rule change override option

CSCsr81665 mixer 4 "WAV converted to PCM/G729a using offline lib, fails to play on 
Windows"

CSCsu70105 telephony 4 VMWS - Recording response includes incorrect stop time.

CSCsx38452 vml 4 Tomcat crash under CML under VMWS

CSCsw86830 vmo 4 VMO creates temp.wav file for playback

CSCsv46588 messaging 5 Message event subscription notification XML tweaks

CSCsw43198 admin 6 BAT tool fails to enable "transferenabled" option for contacts

CSCsr25626 api 6 "VMWS - Add new property ""LocalArrivalTime"" for getMessages()"

CSCsu74906 api 6 VMWS: Provide Mechanism to upload Midlet files to Web Server

CSCsv14650 api 6 VMWS: Add status indicating if an unread Receipt or NDR is present

CSCsv42402 api 6 Record Termination Warning Enhancement

CSCsw26293 cli 6 CLI: LDAP filtering to filter the users in the LDAP directory

CSCsv52480 conversations 6 Prompt for disabling msg notification to a device is confusing

CSCsr20507 core 6 SRM should restart CuFileSync if service is stopped.

CSCsv40758 core 6 CML: IMAPUid needs to be exposed

CSCsr86832 database 6 To support toolchain

CSCsx10222 database 6 Can’retrieve error code via CUALS

CSCsk65946 setup 6 Deliver new Unity rpms to /vob/vos

CSCsq05360 setup 6 Sync up with CUCM libraries for Connection projects

CSCsw47095 setup 6 install logging includes comments

Table 2 Connection Release 7.0(2) and Connection in Cisco Unified CMBE 7.0(2) Resolved Caveats (continued)
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Note Cisco Unified Communications Manager, Cisco Unified Communications Manager Business Edition, 
and Cisco Unity Connection support SNMP traps.

Reconfiguration and Upgrade Guide for Cisco Unity Connection: Renaming the 7.x Publisher Server 
in a Connection Cluster

The procedure in the “Renaming the 7.x Publisher Server in a Connection Cluster” section of the 
“Renaming Cisco Unity Connection 7.x Servers” chapter of the Reconfiguration and Upgrade Guide for 
Cisco Unity Connection Release 7.x is incomplete. Use the following procedure instead.

Do the following procedure to change the host name of the publisher server in a Connection cluster.

To Rename the 7.x Publisher Server in a Connection Cluster

Step 1 If Digital Networking is configured, remove the server from the digital network. See the “Using Digital 
Networking” chapter of the System Administration Guide for Cisco Unity Connection Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/administration/guide/7xcucsagx.htm
l.

Caution Re-adding a server to a digital network can be a time-consuming process. Ensure that you 
thoroughly understand the work required to re-add a server to a digital network before you 
begin this procedure. 

Step 2 On a DNS server, change the DNS record of the publisher server to the new host name.

Step 3 Confirm that the DNS change propagates to the publisher server. Log on to the publisher server by using 
an SSH application, and run the following CLI command:

utils network host <hostname>

Do not proceed if the new host name does not resolve to the correct IP address.

Step 4 Repeat Step 3 on the subscriber server.

Step 5 On the publisher server, change the SMTP domain in Cisco Unity Connection Administration:

a. Expand System Settings > SMTP Configuration, and click Server.

b. Click Change SMTP Domain, and change the value of the SMTP Domain field.

c. Click Save.

Step 6 On the publisher server, change the host name of the publisher server in Connection Administration:

a. Expand System Settings, and click Cluster.

b. Click Find to display a list of servers.

c. Click the host name of the server that you want to rename.

d. On the Server Configuration page, change the value of the Host Name/IP Address field to the new 
name.

e. Click Save.

Step 7 On the subscriber server, change the name by which the subscriber server knows the publisher server:

a. In Cisco Unified Operating System Administration, from the Settings menu, click IP > Publisher.
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b. Change the host name of the publisher server.

c. Click Save.

d. Log on to the subscriber server by using an SSH application, and run the following CLI command 
to restart the server:

utils system restart

Step 8 On the publisher server, change the name of the publisher server in Cisco Unified Operating System 
Administration.

a. From the Settings menu, click IP > Ethernet.

b. Change the host name of the publisher server.

c. Click Save. The publisher server automatically restarts.

d. Wait for the publisher server to finish restarting. When you can log on to Connection Administration 
on the publisher server, continue with Step 9.

Step 9 Log on to the subscriber server by using an SSH application, and run the following CLI command to 
restart the server:

utils system restart

Step 10 Wait for the subscriber server to finish restarting. When you can log on to Connection Administration 
on the subscriber server, continue with Step 11.

Step 11 On the publisher server, run the following CLI command to reset replication:

utils dbreplication reset all

Step 12 Wait until the replication reset process is complete. To determine when the process is completed:

a. Log on to Real-Time Monitoring Tool (RTMT) by connecting to the publisher server.

b. On the System menu, click Performance > Open Performance Monitoring.

c. In the right pane, expand Number of Replicates Created and State of Replication, then 
double-click Replicate_State.

d. In the Object Instances dialog box, click ReplicateCount and click Add.

e. Wait until the value reaches 2.0.

For more information on possible values and their meaning, right-click Replicate_State, and click 
Counter Description.

f. On the File menu, click Exit to exit RTMT.

Step 13 Log on to the publisher server by using an SSH application, and run the following CLI command to 
restart the server:

utils system restart

This command causes the Connection cluster servers to change server status so the publisher server has 
the Secondary status and the subscriber server has the Primary status.

Step 14 Run the following CLI command to change the publisher server to Primary status.

utils cuc cluster makeprimary name_of_publisher_server
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Step 15 If the server was part of a digital network before you renamed the server, readd the server to the digital 
network. See the “Using Digital Networking” chapter of the System Administration Guide for 
Cisco Unity Connection Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/administration/guide/7xcucsagx.htm
l.

System Administration Guide for Cisco Unity Connection: Creating a Calendar Integration with 
Exchange 2007

Added July 9, 2010
The “Creating a Calendar Integration with Exchange 2007” section in the “Creating Calendar 
Integrations” chapter of the System Administration Guide for Cisco Unity Connection Release 7.x (at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/administration/guide/7xcucsagx.htm
l) incorrectly indicates that you can do a calendar integration with Exchange 2007 Server. Calendar 
integrations with Exchange 2007 Server are no longer supported in Cisco Unity Connection 7.0(2).

Note however that contact and text to speech integrations are still supported with Exchange 2007 Server.

System Administration Guide for Cisco Unity Connection: Converting Phone Numbers into 
Extensions

The procedure in the “Converting Phone Numbers into Extensions” section of the “Integrating Cisco 
Unity Connection with an LDAP Directory” chapter of the System Administration Guide for Cisco Unity 
Connection Release 7.x gives the wrong format for a regular expression that converts the first four digits 
of a phone number into an extension. The correct format is:

^[0-9][0-9][0-9][0-9]

System Administration Guide for Cisco Unity Connection: Creating and Installing an SSL Server 
Certificate

In the “Creating and Installing an SSL Server Certificate” section in the “Securing Cisco PCA and IMAP 
Email Client Access to Cisco Unity Connection” chapter of the System Administration Guide for 
Cisco Unity Connection Release 7.x, the task list and two procedures were incorrect, and a procedure 
was missing. Use the information in this section instead of the information in the System Administration 
Guide for Cisco Unity Connection.

Do the following tasks to create and install an SSL server certificate to secure Cisco Personal 
Communications Assistant and IMAP email client access to Cisco Unity Connection:

1. If you are using Microsoft Certificate Services to issue certificates, install Microsoft Certificate 
Services. Do the “To Install the Microsoft Certificate Services Component” procedure on page 31.

If you are using another application to issue certificates, install the application. See the manufacturer 
documentation for installation instructions. Then skip to Step 2.

If you are using an external certification authority to issue certificates, skip to Step 2.

Note If you already have installed Microsoft Certificate Services or another application that can create 
certificate signing requests, skip this procedure.
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2. Create a certificate signing request. Then download the certificate signing request to the server on 
which you installed Microsoft Certificate Services or another application that issues certificates, or 
download the request to a server that you can use to send the certificate signing request to an external 
certification authority (CA). Do the “To Create and Download a Certificate Signing Request” 
procedure on page 32.

3. If you are using Microsoft Certificate Services to export the root certificate and issue the server 
certificate, do the “To Export the Root Certificate and Issue the Server Certificate (Only When You 
Are Using Microsoft Certificate Services to Issue the Certificate)” procedure on page 32.

If you are using another application to issue the certificate, see the documentation for the application 
for information on issuing certificates.

If you are using an external CA to issue the certificate, send the certificate signing request to the 
external CA. When the external CA returns the certificate, continue with Step 4.

4. Upload the root certificate and the server certificate to the Cisco Unity Connection server. Do the 
“To Upload the Root and Server Certificates to the Cisco Unity Connection Server” procedure on 
page 33.

5. Restart the Connection IMAP Server service so that Connection and the IMAP email clients use the 
new SSL certificates. Do the “To Restart the Connection IMAP Server Service” procedure on 
page 34.

To Install the Microsoft Certificate Services Component

Step 1 On any server whose DNS name (FQDN) or IP address can be resolved by all client computers that will 
use the Cisco PCA or that will use an IMAP client to access Cisco Unity Connection voice messages, 
log on to Windows by using an account that is a member of the local Administrators group.

Step 2 On the Windows Start menu, click Settings > Control Panel > Add or Remove Programs.

Step 3 In the left pane of the Add or Remove Programs control panel, click Add/Remove Windows 
Components.

Step 4 In the Windows Components dialog box, check the Certificate Services check box. Do not change any 
other items.

Step 5 When the warning appears about not being able to rename the computer or to change domain 
membership, click Yes.

Step 6 Click Next.

Step 7 On the CA Type page, click Stand-alone Root CA, and click Next. (A stand-alone certification 
authority (CA) is a CA that does not require Active Directory.)

Step 8 On the CA Identifying Information page, in the Common Name for This CA field, enter a name for the 
certification authority.

Step 9 Accept the default value in the Distinguished Name Suffix field. 

Step 10 For Validity Period, accept the default value of 5 Years. 

Step 11 Click Next.

Step 12 On the Certificate Database Settings page, click Next to accept the default values. 

If a message appears indicating that Internet Information Services is running on the computer and must 
be stopped before proceeding, click Yes to stop the services.

Step 13 If you are prompted to insert the Windows Server 2003 disc into the drive, insert either the Cisco Unity 
Connection disc, which contains the same required software, or a Windows Server 2003 disc.
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Step 14 In the Completing the Windows Components Wizard dialog box, click Finish.

Step 15 Close the Add or Remove Programs dialog box.

To Create and Download a Certificate Signing Request

Step 1 Log on to Cisco Unified Operating System Administration.

Step 2 On the Security menu, click Certificate Management.

Step 3 On the Certificate List page, click Generate CSR.

Step 4 On the Generate Certificate Signing Request page, in the Certificate Name list, click tomcat.

Step 5 Click Generate CSR.

Step 6 When the Status area displays a message that the CSR was successfully generated, click Close.

Step 7 On the Certificate List page, click Download CSR.

Step 8 On the Download Certificate Signing Request page, in the Certificate Name list, click tomcat.

Step 9 Click Download CSR.

Step 10 In the File Download dialog box, click Save.

Step 11 In the Save As dialog box, in the Save As Type list, click All Files.

Step 12 Save the file tomcat.csr to a location on the server on which you installed Microsoft Certificate Services 
or on a server that you can use to send the CSR to an external certification authority.

Step 13 On the Download Certificate Signing Request page, click Close.

To Export the Root Certificate and Issue the Server Certificate (Only When You Are Using Microsoft Certificate 
Services to Issue the Certificate)

Step 1 On the server on which you installed Microsoft Certificate Services, log on to Windows by using an 
account that is a member of the Domain Admins group.

Step 2 On the Windows Start menu, click Programs > Administrative Tools > Certification Authority.

Step 3 In the left pane, expand Certification Authority (Local) > <Certification authority name>, where 
<Certification authority name> is the name that you gave to the certification authority when you installed 
Microsoft Certificate Services in the “To Install the Microsoft Certificate Services Component” 
procedure on page 31.

Step 4 Export the root certificate:

a. Right-click the name of the certification authority, and click Properties.

b. On the General tab, click View Certificate.

c. Click the Details tab.

d. Click Copy to File.

e. On the Welcome to the Certificate Export Wizard page, click Next.

f. On the Export File Format page, click Next to accept the default value of DER Encoded Binary 
X.509 (.CER).  
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g. On the File to Export page, enter a path and file name for the .cer file. Choose a network location 
that you can access from the Cisco Unity Connection server.

Write down the path and file name. You will need it in a later procedure.

h. Follow the onscreen prompts until the wizard has finished the export.

i. Click OK to close the Certificate dialog box, and click OK again to close the Properties dialog box.

Step 5 Issue the server certificate:

a. Right-click the name of the certification authority, and click All Tasks > Submit New Request.

b. Browse to the location of the certificate signing request file that you created in the “To Create and 
Download a Certificate Signing Request” procedure on page 32, and double-click the file.

c. In the left pane of Certification Authority, click Pending Requests.

d. Right-click the pending request that you submitted in b., and click All Tasks > Issue.

e. In the left pane of Certification Authority, click Issued Certificates.

f. Right-click the new certificate, and click All Tasks > Export Binary Data.

g. In the Export Binary Data dialog box, in the Columns that Contain Binary Data list, click Binary 
Certificate.

h. Click Save Binary Data to a File. 

i. Click OK.

j. In the Save Binary Data dialog box, enter a path and file name. Choose a network location that you 
can access from the Cisco Unity Connection server.

Write down the path and file name. You will need it in a later procedure.

k. Click OK.

Step 6 Close Certification Authority.

To Upload the Root and Server Certificates to the Cisco Unity Connection Server

Step 1 Log on to Cisco Unified Operating System Administration.

Step 2 On the Security menu, click Certificate Management.

Note If you click Find and display a list of the certificates currently installed on the server, you will 
see an existing, automatically generated, self-signed certificate for Tomcat. That certificate is 
unrelated to the Tomcat certificates that you upload in this procedure.

Step 3 Upload the root certificate:

a. On the Certificate List page, click Upload Certificate.

b. On the Upload Certificate page, in the Certificate Name list, click tomcat-trust.

c. Leave the Root Certificate field blank.

d. Click Browse, and browse to the location of the root CA certificate.
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If you used Microsoft Certificate Services to issue the certificate, this is the location of the root 
certificate that you exported in the “To Export the Root Certificate and Issue the Server Certificate 
(Only When You Are Using Microsoft Certificate Services to Issue the Certificate)” procedure on 
page 32.

If you used an external certification authority to issue the certificate, this is the location of the root 
CA certificate that you received from the external certification authority.

e. Click the name of the file.

f. Click Open.

g. On the Upload Certificate page, click Upload File.

h. When the Status area reports that the upload succeeded, click Close.

Step 4 Upload the server certificate:

a. On the Certificate List page, click Upload Certificate.

b. On the Upload Certificate page, in the Certificate Name list, click tomcat.

c. In the Root Certificate field, enter the filename of the root certificate that you uploaded in Step 3.

d. Click Browse, and browse to the location of the server certificate.

If you used Microsoft Certificate Services to issue the certificate, this is the location of the server 
certificate that you issued in the “To Export the Root Certificate and Issue the Server Certificate 
(Only When You Are Using Microsoft Certificate Services to Issue the Certificate)” procedure on 
page 32.

If you used an external certification authority to issue the certificate, this is the location of the server 
certificate that you received from the external certification authority.

e. Click the name of the file.

f. Click Open.

g. On the Upload Certificate page, click Upload File.

h. When the Status area reports that the upload succeeded, click Close.

Step 5 Restart the Tomcat service (the service cannot be restarted from Cisco Unified Serviceability):

a. Log on to the Connection server by using an SSH application.

b. Run the following CLI command to restart the Tomcat service:

utils service restart Cisco Tomcat

To Restart the Connection IMAP Server Service

Step 1 Log on to Cisco Unity Connection Serviceability.

Step 2 On the Tools menu, click Service Management.

Step 3 In the Optional Services section, for the Connection IMAP Server service, click Stop.

Step 4 When the Status area displays a message that the Connection IMAP Server service was successfully 
stopped, click Start for the service.
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User Moves, Adds, and Changes Guide for Cisco Unity Connection: Creating Cisco Unity Connection 
Users from LDAP Data by Using the Bulk Administration Tool

The procedure in the “Creating Cisco Unity Connection Users from LDAP Data by Using the Bulk 
Administration Tool” section in the “Creating User Accounts from LDAP User Data” chapter of the User 
Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x is incorrect. Use the following 
procedure instead.

To Create Cisco Unity Connection Users by Using the Bulk Administration Tool

Step 1 Log on to Cisco Unity Connection Administration as a user that has the System Administrator role.

Step 2 Expand Tools and click Bulk Administration Tool.

Step 3 Export the data that is currently in the hidden Cisco Unified CM database on the Connection server:

a. Under Select Operation, click Export.

b. Under Select Object Type, click Users from LDAP Directory.

c. In the CSV File field, enter the full path to the file in which you want to save exported data.

d. Click Submit.

Step 4 Open the CSV file in a spreadsheet application or in a text editor, and update the data as applicable. For 
more information, see the “Using the Cisco Unity Connection Bulk Administration Tool” section.

Step 5 Import the data in the updated CSV file:

a. Log on to Cisco Unity Connection Administration as a user that has the System Administrator role.

b. Expand Tools and click Bulk Administration Tool.

c. Under Select Operation, click Create.

d. Under Select Object Type, click Users with Mailbox.

e. In the CSV File field, enter the full path to the file from which you want to import data.

f. In the Failed Objects Filename field, enter the full path of the file to which you want Connection to 
write error messages about users who could not be created.

g. Click Submit.

Step 6 When the import is complete, review the file that you specified in the Failed Objects Filename field to 
verify that all users were created successfully.

Omissions
This section lists new and additional information that is not included in the current documentation for 
Cisco Unity Connection and for Connection in Cisco Unified Communications Manager Business 
Edition. The new and additional information will be incorporated in a future documentation release, or 
as otherwise noted.

Cisco Unified Serviceability Administration Guide Release 7.0(1): SNMP Services

Added July 13, 2009
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In the “SNMP Services” section in the “Understanding Simple Network Management Protocol” chapter 
of the Cisco Unified Serviceability Administration Guide Release 7.0(1), the following row was omitted 
from Table 15-2, “SNMP Services.”

Cisco Unified Serviceability Administration Guide Release 7.0(1): SNMP Management Information 
Base (MIB)

Added July 13, 2009
In the “SNMP Management Information Base (MIB)” section in the “Understanding Simple Network 
Management Protocol” chapter of the Cisco Unified Serviceability Administration Guide Release 7.0(1), 
the following section was omitted.

CISCO-UNITY-MIB

The CISCO-UNITY-MIB uses the Connection SNMP Agent to get information about Cisco Unity 
Connection.

To view the CISCO-UNITY-MIB definitions, go to the following link and click SNMP V2 MIBs:

http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml

Note Cisco Unity Connection supports this MIB. Cisco Unified Communications Manager does not support 
this MIB.

The Connection SNMP Agent supports the following objects.

Cisco Unified Serviceability Administration Guide Release 7.0(1): Configuring CISCO-UNITY-MIB 
Trap Parameters

Added July 13, 2009

Table 3 SNMP Services

MIB Service Window

CISCO-UNITY-MIB Connection SNMP Agent Cisco Unity Connection 
Serviceability > Tools > Service 
Management. Choose a server; 
then, choose Base Services 
category.

Table 4 Cisco-unity-MIB Objects

Object Description

ciscoUnityTable This table contains general information about the Cisco Unity 
Connection servers such as host name and version number.

ciscoUnityPortTable This table contains general information about the Cisco Unity 
Connection voice messaging ports.

General Unity Usage Info 
objects

This group contains information about capacity and utilization of the 
Cisco Unity Connection voice messaging ports.
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In the “Configuring SNMP Trap/Inform Parameters” chapter of the Cisco Unified Serviceability 
Administration Guide Release 7.0(1), the following text should be included as the “Configuring 
CISCO-UNITY-MIB Trap Parameters” section.

Connection only: The Connection SNMP Agent does not enable trap notifications, though traps can be 
triggered by Cisco Unity Connection alarms. You can view Cisco Unity Connection alarm definitions in 
Cisco Unity Connection Serviceability, on the Alarm > Definitions screen.

You can configure trap parameters by using the CISCO-SYSLOG-MIB. See the “Configuring 
CISCO-SYSLOG-MIB Trap Parameters” section.

Command Line Interface Reference Guide for Cisco Unified Communications Solutions Release 7.0: 
Utils Commands

The command below should be included in the “Utils Commands” section of the Command Line 
Interface Reference Guide for Cisco Unified Communications Solutions Release 7.0.

utils cuc networking clear_replication (Cisco Unity Connection Only)

This command stops all Digital Networking replication activities occurring on the server.

Command Syntax

utils cuc networking clear_replication

Usage Guidelines

This command stops the Connection Digital Networking Replication Agent, deletes the drop, queue, and 
pickup replication folders, clears the status of in-progress directory pushes to or pulls from this server, 
and restarts the Connection Digital Networking Replication Agent. Depending on the size of the 
replication folders, this operation may take several minutes

Requirements

Command privilege level: 1

Allowed during upgrade: No

User Moves, Adds, and Changes Guide for Cisco Unity Connection: Integrating Existing Cisco Unity 
Connection User Accounts with LDAP User Accounts

Added March 9, 2009
The following text should be included as the “Integrating Existing Cisco Unity Connection User 
Accounts with LDAP User Accounts” section in the “Creating User Accounts from LDAP User Data” 
chapter of the User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x. 

When you configured Cisco Unity Connection to integrate with an LDAP directory by using the 
procedures in the “Integrating Cisco Unity Connection with an LDAP Directory” chapter of the System 
Administration Guide for Cisco Unity Connection, you synchronized Connection data with data in the 
LDAP directory. That process invisibly imported the LDAP data into a cache on the Connection server.

When you use the Bulk Administration Tool to integrate existing Connection users with LDAP users, 
you:

1. Export the data from the cache into a CSV file.

2. Remove from the CSV file any users who you do not want to synchronize with users in the LDAP 
directory.
37
Release Notes for Cisco Unity Connection Release 7.0(2)

OL-18980-01



  Documentation Updates
3. Import the updated CSV file into the Connection database, which synchronizes Connection users 
with LDAP users and sets the LDAP flag in the Connection database.

Caution When you import LDAP user data into the Connection database, existing values for the fields 
being imported are overwritten with values from the LDAP database.

If you have configured Connection to periodically resynchronize Connection data with LDAP data, new 
values in the LDAP directory are automatically imported into the Connection database during the next 
automatic resynchronization. However, if new users have been added to the LDAP directory, this 
resynchronization does not create new Connection users. You must manually create new Connection 
users by using either the Import Users tool or the Bulk Administration Tool.

To Integrate Existing Cisco Unity Connection Users with LDAP Users

Step 1 Log on to Cisco Unity Connection Administration as a user that has the System Administrator role.

Step 2 Expand Tools and click Bulk Administration Tool.

Step 3 Export the data that is currently in the cache on the Connection server:

a. Under Select Operation, click Export.

b. Under Select Object Type, click Users from LDAP Directory.

c. In the CSV File field, enter the full path to the file in which you want to save exported data.

d. Click Submit.

This exports LDAP user data from the cache and sets the LDAP-integrated flag in the CSV file.

Step 4 Edit the CSV file to remove any Connection users who you do not want to synchronize with users in the 
LDAP directory. For more information, see the “Using the Cisco Unity Connection Bulk Administration 
Tool” appendix in the User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 7.x.

If you want every user in the LDAP directory to be a Connection user, you skip this step.

Step 5 Import the data that you edited in Step 4:

a. Log on to Cisco Unity Connection Administration as a user that has the System Administrator role.

b. Expand Tools and click Bulk Administration Tool.

c. Under Select Operation, click Update.

d. Under Select Object Type, click Users with Mailbox.

e. In the CSV File field, enter the full path to the file from which you want to import data.

f. In the Failed Objects Filename field, enter the full path of the file to which you want Connection to 
write error messages about users who could not be created.

g. Click Submit.

Step 6 When the import is complete, review the file that you specified in the Failed Objects Filename field to 
verify that all Connection users were successfully integrated with the corresponding LDAP users.
38
Release Notes for Cisco Unity Connection Release 7.0(2)

OL-18980-01



  Troubleshooting Information
User Workstation Setup Guide for Cisco Unity Connection Release 7.x: Creating and Configuring an 
Account in IBM Lotus Notes

In the “Creating and Configuring an Account in IBM Lotus Notes” section in the “Configuring an Email 
Account to Access Cisco Unity Connection Voice Messages” chapter of the User Workstation Setup 
Guide for Cisco Unity Connection Release 7.x, the following information was omitted:

When using Lotus Notes version 7.x to access Connection voice messages, you must first configure 
Notes to connect to a Domino account before configuring the Connection account. 

Troubleshooting Information
Cisco Unity Connection troubleshooting information can be found in the Troubleshooting Guide for 
Cisco Unity Connection Release 7.x at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/troubleshooting/guide/7xcuctsgx.ht
ml.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed 
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free 
service and Cisco currently supports RSS version 2.0.

Cisco Product Security Overview
This product contains cryptographic features and is subject to United States and local country laws 
governing import, export, transfer and use. Delivery of Cisco cryptographic products does not imply 
third-party authority to import, export, distribute or use encryption. Importers, exporters, distributors 
and users are responsible for compliance with U.S. and local country laws. By using this product you 
agree to comply with applicable laws and regulations. If you are unable to comply with U.S. and local 
laws, return this product immediately

Further information regarding U.S. export regulations may be found at 
http://www.access.gpo.gov/bis/ear/ear_data.html.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of 
Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The 
use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and 
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and 
coincidental.

© 2012 Cisco Systems, Inc. All rights reserved.
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